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Introduction
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Goals of a term paper

▶ Learn about a specific subject
▶ Learn how to write a good term paper

▶ Formally correct scientific writing
▶ Report on existing research
▶ Broad literature survey
▶ (Critical survey of one paper
▶ Describe it structurally & evaluate critically the study/methods/findings
▶ Define new research questions and shows prospective avenues for research
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How to start?

Often, you have one or two seminal papers that you can start with:
▶ Read the main papers in detail!
▶ What are the main statements?
▶ Which one(s) do you want to analyze?

But how to read empirical papers? ...
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Reading papers
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How to read empirical papers?
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Typical paper structures

▶ Introduction
▶ Model & theory
▶ Data
▶ Empirical strategy
▶ Results
▶ Conclusion

▶ Introduction
▶ Model & theory
▶ Data
▶ Empirical strategy
▶ Results
▶ Robustness checks
▶ Conclusion

▶ Introduction
▶ Model & theory
▶ Data sources
▶ Context of data
▶ Summary statistics
▶ Empirical strategy
▶ Main results
▶ Other results
▶ Robustness checks
▶ Conclusion
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Grasp main information

Read a paper to answer 4 questions:
1. What is the main research question?
2. What is the main result?
3. What is the identification strategy / method?
4. What is the data used?
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Grasp main information

Skim paper in 5 minutes
1. What is the main research question?

⇒ Read abstract
2. What is the main result?

⇒ Find main table or graph (section: results) – outcome and treatment variable
3. What is the identification strategy / method?

⇒ Find keywords, such as “randomized experiment”, “IV”, etc. (section: empirical
strategy)

Stop? Or do you want to know more details?

9/91



Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

Continue reading

4. What are the data used?
▶ Data sources? Institutional context?
▶ How large are the effects in this context?

▶ Summary statistics table (section: data)

5. Are you convinced that the main finding is correct?
▶ (section: robustness checks)

6. What is the general context?
▶ (sections: Introduction & conclusion)

7. What is the theory?
▶ How are people behaving? How are policies working?
▶ (section: Theory and “literature”)

10/91



Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

Defining your topic

▶ Develop your research objective
▶ “What do you want to do in the paper?”

▶ Develop your research question
▶ “Which question(s) do you want to answer?”
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Defining your topic

1. I analyze...

2. Because I want to show...

3. In order to...
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Defining your topic

1. I analyze...
the relation of decentralization and deforestation

2. Because I want to show...
that shifting responsibilities to the local administrations increases the likelihood of
corrupt activities in the forestry sector

3. In order to...
raise attention of the potential negative environmental effects during the transition
of political systems
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Literature search
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Where to find research literature
(some)

▶ Have a look at the cited papers in the preliminary / main literature
▶ Search in Journals
▶ Search via research databases

▶ UTD library
▶ Ebscohost
▶ ScienceDirect
▶ JSTOR
▶ GoogleScholar – for more experienced researchers
▶ ...
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What are good and reliable sources?

▶ Books?
▶ Journal articles?
▶ Blogs?
▶ Newspaper articles?
▶ Working papers...?
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Know the top jouranls in your field!

Rankings in Economics:
▶ SCImago Journal Rank (SJR)
▶ Tinbergen list (often used in the EU)
▶ IDEAS/REPEc
▶ See journal.ranking.xlsx on eLearning!
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The big 5+ journals of economics

▶ American Economic Review (AER)
▶ Econometrica
▶ Quarterly Journal of Economics (QJE)
▶ Journal of Political Economy (JPE)
▶ Review of Economic Studies (Rev Econ Stat)
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Other top general economics journals
My personal choice

▶ American Economic Journal: Applied Economics
▶ Review of Economics and Statistics
▶ American Economic Journal: Economic Policy
▶ Journal of the European Economic Association
▶ Journal of Public Economics
▶ Economic Journal
▶ Journal of Economic Literature
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Environmental Economics journals
My personal choice

▶ Review of Environmental Economics and Policy (REEP)
▶ Journal of the Association of Environmental and Resource Economists (JARE)
▶ Journal of Environmental Economics and Management (JEEM)
▶ World Development (WD)
▶ American Journal of Agricultural Economics (AJAE)
▶ Ecological Economics (EE)
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Development economics
My personal choice

▶ World Bank Economic Review
▶ Journal of Development Economics
▶ World Development
▶ Journal of Development Studies
▶ Journal of Conflict Resolution
▶ Journal of Health Economics
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Interdisciplinary journals

(some repeated)
▶ Science
▶ Nature
▶ Proceedings of the National Academy of Sciences (PNAS)
▶ PLOS One

▶ American Journal of Agricultural Economics
▶ Land Use Policy
▶ World Development
▶ Land Economics
▶ Ecological Economics
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Remotes Sensing journals

▶ Remote Sensing of Environment
▶ Do you know some?
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Good working papers

▶ NBER Working Papers (National Bureau of Economic Research)
▶ CEPR Working Papers (Center for Economic Policy Research)
▶ IZA Discussion Paper Series
▶ Working Papers of the IMF, ECB, World Bank(?), etc.
▶ Working Paper series of good universities
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Literature research
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Selection of relevant and adequate papers

Iteratively read and reread the papers
with growing attention to detail!
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Selection of relevant and adequate papers

First reading: be quick:
▶ Title
▶ Abstract
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Selection of relevant and adequate papers
After first reading: decide:
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Organize your literature
▶ Use a reliable filing system!
▶ Do not lose ideas or references!
▶ Save all quotes, papers, sources
▶ Use bibliographic software (citavi, jabref,...)

▶ I strongly recommend using Latex/Overleaf.com + Jabref
▶ Would you like an introduction to Overleaf.com + Jabref?
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Exposé / Proposal
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What is an exposé?

Why do we need it?
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Content

▶ What is your exact research question?
▶ State the problem you are facing
▶ Why is it relevant? Motivate!
▶ How are you going to proceed?

⇒ “Preview of what the term paper is about.”
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Content Exposé

Research design proposal
▶ 1st page: Introduction
▶ 2nd page: Data & Empirical approach
▶ 3rd page: Outline
▶ 4th page: List of references

Bibliography essay
▶ 1st page: Introduction
▶ 2nd page: Primary literature (3–4)
▶ 3rd page: Outline
▶ 4th page: List of references
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Formality

▶ 1st page includes:
▶ Top Left: Course name, Professor name
▶ Top right: Student name, ‘Exposé’, Date
▶ Title

▶ See also guideline “w00_guidline-writing.pdf”
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Content of the introduction

▶ State the problem you are facing
▶ Why is it relevant?
▶ What is your research question, exactly?
▶ How are you going to proceed?
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Data & empirical approach

▶ Describe the data that you (could) use your proposed research design
▶ What is the unit of analysis?
▶ Focus on outcome and main explanatory variable (e.g., policy intervention)
▶ What is the data source
▶ How are the variables operationalized?

▶ Formulate your empirical approach
▶ Describe your identification strategy, i.e., why is it measuring (potentially) measuring

a causal identification
▶ Write out your main estimation equation
▶ Describe the equation in detail
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Primary literature

▶ Choose 3–4 main papers
▶ Why are they interesting?
▶ What are they contrasting in?
▶ How are these a good start for the literature overview?
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Outline (examples)

Research design proposal
1. Introduction
2. (Context &) theoretical framework

(/Literature overview)
▶ The context of X
▶ Policy Y
▶ Hypotheses

3. Data
4. Empirical approach
5. Expected results
6. Conclusion

Bibliography essay
1. Introduction
2. Overview of different theories of the

resource course
3. Oil abundance corrupts
4. Interpretation of results and political

implications
5. Conclusion
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References
... and of course, your references, nicely formatted (more later)
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Term paper

(Bibliographic essay / Research design proposal)
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Let’s discuss...

1. Introduction
2. Main part of the paper
3. Discussion
4. Conclusion
5. References

6. Structuring arguments
7. Style
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Introduction

▶ Why do we need an introduction?

▶ What is the content of a good intro?

▶ Does an intro have a structure?

▶ When shall I write the introduction?

42/91



Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

Introduction
Structure of an introduction

▶ Introduction to the topic
▶ General background info
▶ Topic of the paper and its relevance
▶ Short literature review + gap

▶ Research objective / question
▶ Methodology
▶ Contribution (hint to the results)
▶ Outline
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Introduction
Content of an introduction

▶ What is the topic?
▶ Why is it relevant?
▶ What is the research question / objective?
▶ How does the paper proceed to answer the question?
▶ Contribution of the paper
▶ Outline of the structure
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Introduction
Take-off

Don’t know how to start?
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Introduction
Take-off

You could (/should)...
▶ Formulate the research question
▶ State the aim of the analysis
▶ Tell a story
▶ Use a quote
▶ Link the topic to a present occasion
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Introduction
Take-off

Formulate the research question:
Is conditionality necessary in conditional cash transfer programs to improve
forest conservation or is it actually that only the financial restrictions hinder
households to invest in forest-benign land uses so that handing out cash au-
tomatically reduces deforestation rates? This is an important question for de-
signing such programs...
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Introduction
Take-off

State the aim of the analysis:
This paper compares the effects of conditional and unconditional cash transfers
on deforestation rates in order to improve the design of such programs.
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Introduction
Take-off

Tell a story:
“Chico Mendes was a Brazilian rubber tapper and forest conservation activist
defending the human rights of smallholders and indigenous people. On Decem-
ber 22, 1988, he was murdered after receiving death threats from land owners.”
The story of Chico Mendes shows how forest conservation is embedded into
the distribution and enforcement of land rights in the Amazon.
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Introduction
Take-off

Use a quote:
“At first, I thought I was fighting to save rubber trees, then I thought I was

fighting to save the Amazon rainforest. Now I realize I am fighting for
humanity”

– Chico Mendes

The tragedy of Chico Mendes, a conservation activist who was shot for helping
indigenous people defend their traditional land rights, is still emblematic of the
insufficient level of law enforcement in the rural parts of the Amazon.
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Introduction
Take-off

Link the topic to a present occasion:
Mexico’s Payments for Hydrological Services Program is an environmental con-
ditional cash transfer program to farmers for conserving standing forests on
private land. The program was very successful in reducing deforestation rates
while it raised the welfare of non-poor households. It is a perfect example that
conditional cash transfers cannot fulfill two goals at the same time.
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Main part

▶ What should be in the main part of the paper?

▶ What is its structure?

52/91



Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

Main part
Structure

▶ Background information/Framework Theories, definitions, literature review
▶ Classification and explanation of the single parts

▶ Analysis of your paper
▶ Discussion

▶ Bring the unique parts together
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Main part
Structure - Examples

Research design proposal
2. (Context &) theoretical framework

(/Literature overview)
▶ The context of X
▶ Policy Y
▶ Hypotheses

3. Data
4. Empirical approach
5. Expected results

Bibliography essay
2. Overview of different theories of the

resource course
3. Oil abundance corrupts
4. Interpretation of results and political

implications
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Main part
Report on literature

▶ Who has done the study?
▶ What has been done in the study?
▶ Where did the study have taken place?
▶ Which methods have been used?
▶ What did they find?
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Main part
Report on literature (cont.)

Nolte et al. (2013) investigate the effect of protected areas on forest losses in the
Brazilian Amazon. Using a spatial matching approach, they conclude that, on average,
deforestation rates decrease within protected areas, with higher effects for strictly
protected reserves. Likewise, Herrera et al. (2019) study the role of governmental
agencies for the efficiency of protected areas; they affirm...
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Main part
Report on literature (cont.)

▶ Structure and link them together
▶ Use conjunctive adverbs like:

▶ Moreover, additionally, ...
▶ Likewise, similarly, also, in the same way. . .
▶ In contrast to, contrary, compared to, despite. . .

▶ Use verbs like:
▶ Affirm, support, confirm, justify...
▶ Rebut, relatives...
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Main part in Bibliographic essay

▶ Theoretical framework
▶ Empirical evidence
▶ Contrasting theories and/or evidence

▶ What are strengths and weaknesses?
▶ What is the new perspective?
▶ What is the research gap?
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Main part in Research Design
▶ Context

▶ Theoretical framework with a critical literature review
▶ Describe the research context
▶ Introduce and describe the policy intervention
▶ Make hypothesis (main effect, heterogeneities, potential mechanisms)

▶ Data
▶ Describe data and sources
▶ How will the data be operationalized

▶ Empirical strategy
▶ Estimation equation
▶ Explain identification strategy

▶ Expected results
▶ Expected results
▶ Significance of research

▶ For research, policymakers, society
▶ Timeline with Gantt chart
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Discussion

▶ Summarize the results
▶ Validate your results
▶ Create a context for your research

▶ compare it with other studies
▶ explain in the framework of a theory
▶ what can we learn out of it
▶ external validity
▶ Everything taken into account: what

is the answer to your research
question?

▶ Outlook
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Conclusion

▶ Why do we need a conclusion?

▶ What is the content of a good conclusion?

▶ Does a conclusion follow a structure?

▶ When should I write the conclusion?
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Conclusion
Structure

▶ Short summary of the main results
▶ Importance of the analysis
▶ Directly answer the research question
▶ Future prospects
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List of references

▶ All papers you used & cited
▶ No additional papers
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Style

Build a clear line of arguments!

Tell a story!
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Structure your arguments

Each paragraph should contain a logically self-contained piece of argumentation
▶ 1st sentence: Statement
▶ Next few: Argument
▶ Last sentence: Leads over to the next paragraph

65/91



Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

Structure your arguments

Example:
▶ Hypothesis: Payments for environmental services affect deforestation rates in

various ways.
▶ Argument: First, they relieve the cash constraints of rural farmers, facilitating new

investments into potentially forest-benign activities. Secondly, they set up a
monitoring mechanism by which the detection probability of illicit activities
increases (X et al. XXX). ...

▶ Link: But, it not only changes the incentives of participating farmers, it also
changes ...
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Structure your arguments

Example (2):
▶ Hypothesis: On average, migrants are better educated.
▶ Argument: This is because human capital is often the only asset they can take

with them when they migrate. Therefore, migrants invest more into human capital
accumulation (X et al. 2014).

▶ Link: However, causality may also run in the opposite direction as better-educated
migrants are more likely to select into the migration stream.
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Structure your arguments

Editing trick
▶ Read only the first sentences of each paragraph of the final draft of your paper
▶ Are they still understandable? Do they tell everything you want to tell? Is there a

red line of arguments?
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Select your audience well

▶ Avoid being too colloquial
Do not use expressions of oral speech (e.g., “Don’t” “can’t”)

▶ Avoid journalist style
e.g., no figurative speech, metaphors, ...

▶ Do not explain general knowledge
▶ Explain intuition very carefully, go beyond derivations
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Be precise
and

keep it simple!
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A few suggestions for a good (scientific) style

▶ Use most of the time the active voice
▶ Write complete sentences
▶ Keep one tense
▶ Be dispassionate and precise
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Active vs. passive voice

Active voice
▶ An agent (SUBJECT) is doing s.th.
▶ “The researchers argued that the Earth

is flat.”

Passive voice
▶ Something is BEING DONE
▶ “It has been argued that the Earth is

flat.”
→ BY WHOM?

▶ “It has been argued (by the
researchers) that the Earth is flat.”
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Active vs. passive voice

Use the active voice
▶ In order to make clearer, more direct

statements
(In most cases)

Use the passive voice
▶ For stylistic reasons—if the agent is

relatively unimportant:
▶ “rules are made to be broken.”
▶ “A new discovery has been made...”
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Avoid sentence fragments

▶ Make sure every sentence has a main verb and a subject!
▶ Consider the following examples:

▶ “The authors have several findings. On wages, employment duration and working
conditions.”

▶ “A very important question.”
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Keep one tense

1. Establish the main tense for your paper (preferably present) and keep it
consistently
▶ e.g., this paper argues, the results show, we find, our regressions take twenty

minutes to run, X and Y argue that Z finds, W concludes. . .
AND NOT

▶ X and Y ran a regression, Z argued, and W modeled this as...
2. Deviate from this rule only when there is a logical shift in the time frame

▶ e.g., eventually in the conclusion: this paper argued, the results emphasized, etc.
▶ or when referring to earlier strands of literature (shift to past tense), etc.
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Citations

Citations are needed...
▶ when making general statements
▶ when referring to numbers
▶ when referring to ideas or work of others
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Citations: Example 1
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Citations: Example 2
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Citations: Direct quote

▶ Used only for really exceptionally perfect statements
Example:

“[...] payments for environmental services (PES) can be defined as: (1) vol-
untary transactions, (2) between service users, (3) and service providers, (4)
that are conditional on agreed rules of natural resource management, (5) for
generating offsite services” (Wunder 2015, p.421).
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Citations: Indirect quote

▶ Be used a lot
▶ Be cautious! Indirect quotes are quotes said in your own words. Slightly changing

the order of the sentence is not enough! (We check for plagiarism!!)
Examples
▶ Moreover, there is a broad consensus that agricultural growth is pro-poor and

pro-growth (Thirtle et al. 2001).
▶ Evidence-based policymaking has a long tradition in medical research where

experimental trials are intensively used since the 1970s (cf. Cochrane, 1972).
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Citations: Plagiarism example
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List of references

How to list...?
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Journal articles

Author -year of publication – title - name of journal – volume (issue) – pages.
▶ Atkin, David (2016): “Endogenous skill acquisition and export manufacturing in

Mexico.” American Economic Review, 106(8): 2046-2085.
▶ Autor, D. H., Dorn, D., Hanson, G. H. and Song, J., 2014. Trade adjustment:

Worker-level evidence. Quarterly Journal of Economics 129(4), p. 1799-1860.
▶ Davis, L. W. and Kahn, M. E. (2010): International trade in used vehicles: The

environmental consequences of NAFTA. In American Economic Journal: Economic
Policy, 2(4), p. 58-82.
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Working paper

Author – year of publication – title – type – paper nr – name of institution – location of
institution
▶ Nordhaus, W. D. (2006): The “Stern Review” on the Economics of Climate

Change, NBER Working Paper 12741, National Bureau of Economic Research,
Cambridge.

▶ Duggan, V., Rahardja, S., and Varela, G. (2013). Service Sector Reform and
Manufacturing Productivity: Evidence from Indonesia. World Bank Policy
Research Working Paper, 6349, The World Bank, Washingtion D.C.
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Books

Author -year of publication – title - publisher - edition
▶ Grossman, G. M. and Helpman, E. (1991). Innovation and Growth in the Global

Economy. MIT Press, Cambridge, MA.
▶ Coleman, James S.; Coleman, James Samuel (1994): Foundations of social theory :

Harvard University Press.
▶ Ito, Sanae (1999): The Grameen Bank: rhetoric and reality : University of Sussex.
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Articles in anthology

Author -year of publication – title – (author/publisher of anthology)- anthology - pages
▶ Kanbur, Ravi (2006): The economics of international aid. In Handbook of the

Economics of Giving, Altruism and Reciprocity 2, pp. 1559–1588.
▶ Duflo, E., Glennerster, R., Kremer, M. (2007). Using Randomization in

Development Economics Research: A Toolkit. In: Schultz, T.P., Strauss, J.A.
(Eds.), Handbook of Development Economics, Chapter 61. North-Holland, Elsevier
Science Pub. Co., Amsterdam, 38953962.
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Electronic sources articles

Author -year of publication – title - hyperlink – date of availability
▶ Nuñez, David, Carmen Fernandez-Gago et al. “D: C-5.1 Metrics for

Accountability.” Accessed May 9, 2014. http://a4cloud.atc.gr/sites/
default/files/D35.1%20Metrics%20for%20accountability.pdf.

▶ Bharadwaj, P., and Vogl, T. (2015): Crisis and Human Biology, available at
http://www.princeton.edu/~tvogl/bharadwaj_vogl_crisis.pdf,
17.02.2016.

▶ Dasgupta, P. S. (2007): Discounting Climate Change, Discussion Paper, University
of Cambridge. Download unter: http:
//www.econ.cam.ac.uk/faculty/dasgupta/pub07/stavins_june07.pdf
(accessed on July 1, 2012).

87/91

http://a4cloud.atc.gr/sites/default/files/D35.1%20Metrics%20for%20accountability.pdf
http://a4cloud.atc.gr/sites/default/files/D35.1%20Metrics%20for%20accountability.pdf
http://www.princeton.edu/~tvogl/bharadwaj_vogl_crisis.pdf
http://www.econ.cam.ac.uk/faculty/dasgupta/pub07/stavins_june07.pdf
http://www.econ.cam.ac.uk/faculty/dasgupta/pub07/stavins_june07.pdf


Intro Reading papers Your topic Literature (re-)search Exposé Term paper Style References

3 rules

1. Be consistent! Choose one citation style and stick to it!
2. Organize your list alphabetically! By the Family name of the first author + by the

year of publication
3. A reference is a full sentence! It starts with a CAPITAL letter + Ends with a point.
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Formal requirements

▶ Include time for formatting
▶ Title page, correct margins, typeface...
▶ Please see section 2 of ”Guideline for writing a thesis”
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